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Chapter 1

Network License

Troubleshooting

Problem: License server does not run

Verify server status by running the WlmAdmin.exe application
(C:\Program Files\Rainbow Technologies\Admin\
Admin.net\Win32). If your server is not listed under Subnet Servers, follow
the instructions below.

1. If the license server computer is running Windows XP with Service Pack 2 or
Windows 2003 Server it may be necessary to set up an exception in Windows
Firewall. Open Control Panel and check the status of the Windows firewall.
If the status is On, add an exception for UDP port 5093 (Figure 1-1). Open
this port if it is blocked by any other active firewall software running on the
server.

g

General | Exceplions | Advanced

‘Windows Firewall is blocking incoming network connections, except for the
programs and services selected below. Adding exceptions allows some programs
to work better but might increase your security risk.

Programs and Services:

[ Name

| BAFile and Printer Shating
Remote Assistance
Remote Desktop
SentinelLM

CJUPNP Framework Edit a Port @

| Use these settings to open a port through Windows Firewall. To find the port
| number and protocol, consult the documentation for the program or service you
i want to use.

Add Program... Add Port... Name: isﬁnl‘"elLM

. 5093
Display a notification when Windows Fotnuanbe B

OTeP ®UuoP
What are the risks of allowing exceptions}

What are the risks of opening a port?

TR

Figure 1-1 Windows Firewall
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2. If opening the port does not resolve the problem, restart the license server as
shown below.

For Windows NT or later: Go to Start | Control Panel | Administrative
Tools, and then double click on Services. A service named SentinelLM
should be listed (see Figure 1-2). If its status is Stopped, right click on it and
select Start from the pop-up menu. If its status is Started, restart it by
clicking on Restart from the pop-up menu.

Fle Action View Help

& ‘l@ Il m

1%, Services (Local) Name Description | Status Startup Type | Log On As ~

= SentinelLM Started Automatic

%Server Supports fil.,,  Started Automatic

@y chell Hardware Det..,  Providesn...  Started  Automatic | P

%Smart Card Manages a... Manual Pause

44501 Server (SQLEX... Providesst.. Started  Automatic

%SQL Server Active ... Enablesint... Disabled

SOL Server Browser  Provides S...  Started Automatic All Tasks »
%SQL Server V55 Writer Provides th... Started Automatic
%SQLSERVERAGENT Manual
%SSDP Discovery Ser... Enables dis... Manual Properties

Extended A, Standard

Stop and Start service SentinelLM on Local Computer

Refresh

Help

Figure 1-2 SentinelLM Service on License Server

For Win 9x: If the license server is running, a separate window will display
the message: “License Server Running”. Close this window to stop the license
server. Open Windows Explorer and go to C:\Program

Files\Rainbow Technologies \SentinellM7.2.0.23
Server\English\. Double click on 1serv9x.exe to restart the License
Server.

Problem: Error [19] or Error [17] when adding license
SentinelLM: Error [19]: Failed to add license code

This error occurs when an incorrect or incomplete license code is entered. Make
sure the correct license code is copied and pasted in its entirety from the license e-
mail (including the portion after “#” that shows company name and quantity of
seats), and then try again. If error persists, follow the procedure below to add the
license code manually.

1. Open Windows Explorer and go to the folder that contains the 1servrc file.
The default path is C:\Program Files\Rainbow
Technologies\SentinellM 7.2.0.23 Server\English\.

Network License 1-2



Structure|Point

CONCRFTF SOFTWARF SOI UTIONS

Make sure the first character of the file name is “€” (for library), not “I” (for
International) or “1”’ (one).

2. If there are multiple license codes in the 1servrc file, make sure only one
license code appears per line. If you need to add a new license code, make
sure the new license code is entered on a new line. You may need to uncheck
Word Wrap in the Format menu as shown in Figure 1-3.

B lservic - Motepad
File Edit View Help

ESHFJSH EDAFKSBDVEBFDSLKIGLDKGLEDSGLE
DLEGJDS  Font, PUT4JLEYLEKJS4VYLS3RIGTLKISLETY
LESeJ7JHJHLSLETS6KIVSLYHDENGDSGADIGHIFGDSFEHDF HC

Uncheck Word Wrap and ensure that
there is anly one license code per line

< In this example, there are three license
codes in three lines, respectively

Figure 1-3 Uncheck Word Wrap in Notepad

3. The 1servrc file must NOT have any extension. It is a common mistake
that a “.txt” is appended to the filename. By default, Windows Explorer
hides all the known extensions including “.txt”. To turn off this feature, click
on Folder Options in the Tools menu, select View tab, and uncheck Hide
extensions for known file types as shown in Figure 1-4.

General | View | File Types | Offline Files

Folder wiews
“fou can apply the view [such as Details or Tiles] that
you are using for this folder to all falders.

[ feply to &lFolders | [ Reset AllFolders

Advanced settings:
Dizplay the full path in the title bar ~
[ Do nat cache thumbnais
() Hidden fles and folders
© Do not show hidden files and folders
&) Show hidden fies and folders
1] e tersons oo e s >
Hide protected operahing system files [Recommended)
[ Laurch folder windows in a separate process
() Managing pairs of Web pages and folders
® Show and manage the pai as a single file
(O Show both parts and manage them individually
(O Show both parts but manage as a single file hd

Figure 1-4 Show Extensions for Known Types in Windows Explorer

Network License 1-3
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4. Restart SentinelLM service (refer to Problem: License server does not run,
part 2) or reboot the server for the new license to take effect.

Problem: Client computer cannot find license server

1. Restart SentinelLM (refer to Problem: License server does not run, part 2) or
reboot the server after license code is entered into the 1servrc file.

2. Using the WlmAdmin.exe tool (located in C:\Program Files\
Rainbow Technologies\Admin\Admin.net\Win32), make sure
the license server is running properly. Verify the feature name and version
listed under the server name (see Figure 1-5Figure 1-5).

T WimAdmin E@E‘

File Edit View Help

+ ) Defined Servers
=28 Subnet Servers

=3 p3dn-268

Server information

Server name: PI40-268 IP addiess; | 192162100214
+I-[7 spe=am 3.00
e8| sp Columin 4,00
1 [ spFrame 1,50 Feature information
7B sprats 700 Feature name: | spColumn Yersion: | 40
1 [7 spslab 3.00
-7 spweall 3.50 Statist
e In use: Totek  Queued
Total users: 0 5 0
Reserved i 0
Commuter 0 5
Capacity 0 0

Redundant: No Mumber of servers: 1
Detailed information

Lizense Info | Clent Infa

License type: Nomal license  Start date:

Allow commuter license:

Vo End dats

‘wed Apr 01 00:00:00 2003

License has no swpiration

Criteria

[ Walue

[=

Addiive license
Check fime tamper
Hold time

Yes
Yes
0secs

Holding ciiteria Wendar speciisd

Key lielime 600 secs

Lag encryption level i

Majority tule: Ho

Number of subnets i v

Rezdy UM

Figure 1-5 All the features are installed successfully

3. Verify that the software version installed on the client workstation is
supported by the version of the license installed on the license server. Please
refer to http://www.structurepoint.org/update/index.asp for details.

4. Open Windows Explorer, and then go to the StructurePoint software folder.
The default path for spMats is C:\Program Files\
StructurePoint\spMats. Open lshost.txt. Make sure that either

Network License 1-4
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the IP address or the license server name is in this file (.these can be used
interchangeably). One may work better than the other depending on the IP and
DNS settings in your network. If the 1shost. txt file is empty or contains
the keyword: “LAN,” the client application (e.g. spMats) will try to obtain the
license by broadcasting a request in the subnet. If the license server and the
client are in different subnets, the IP address or the name of the license server
must be entered into the 1shost . txt file on the client computer.

For other network license related issues, please refer to the FAQ — Network
License section on our website at:
http://www.structurepoint.org/support_fag network license.asp.

Problem: License server does not release licenses

When StructurePoint software is closed on a client workstation, the license is
released and becomes available to other client workstations. If the license is not
released automatically, try the following:

e Wait 10 minutes and run the application on client computer again.
SentinelLM checks the status of all the licenses on client computers and
releases a license automatically if a connection has been inactive for about 10
minutes.

e Restart the SentinelLM service (see Problem: License server does not run,
Part 2).

e Reboot the license server.

Network License 1-5
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Chapter 2

Standalone License

Troubleshooting

Problem: License code is not accepted

After copying and pasting the license code into the License Code text box and
clicking Next, an error message, such as Error [17], appears stating that the license
code cannot be added. There are two solutions to this issue.

Solution 1: Add license code to the 1servrc file manually

1.

3.

Open Windows Explorer and go to the folder that contains the 1servrc file.
The default path is C: \Program Files\StructurePoint\ spMats.
Make sure the first character of the file name is “€” (for library), not “I” (for
International) or “1” (one).

Uncheck the Word Wrap in the Notepad Format menu as shown in Figure
2-1. There should already be one line of text in this file. It is the default 15-
day trial license. Go to the beginning of the second line and paste the new
license code there. You should have a total of two lines of text.

If you have multiple license codes in 1servrc, make sure there is only one
license code per line. If you need to append a new license code to an existing
1servrc file, make sure the new license code is entered in a new line.

Mrap EDAFKSBDVEBFDSLKIGLDKGLEDSGLE
DLEGJDS  Font... PUT4JLEYLEKJS4VYLS3RIGTLKISLETY
LESeJ7JHJHLSLETS6KIVSLYHDENGDSGADIGHIFGDSFEHDF HC

Uncheck Word Wrap and ensure that
there is anly one license code per line

< In this example, there are three license
codes in three lines, respectively

Figure 2-1 Uncheck Word Wrap in Notepad

The 1servrc file must NOT have any extension. It is a common mistake
that a “. txt” is appended to the filename. By default, Windows Explorer
hides all the known extensions including “.txt”. To turn off this feature,
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click on Folder Options in the Tools menu, select View tab, and uncheck
Hide extensions for known file types (Figure 2-2).

Solution 2: Set environment variable LSFORCEHOST to no-net

To add a standalone license, set the environment variable LSFORCEHOST to “no-

net.” To add an environment variable, follow the steps below (assuming Windows
XP).

Folder Options Egl

General | View | File Types | Offline Files

Folder wiews

. “fou can apply the view [such as Details or Tiles] that
you are using for this folder to all falders.

[ Apply to AlFolders | [ Reset All Folders

Advanced settings:
Dizplay the full path in the title bar ~
[] Donat cache thumbnails
(5 Hidden files and folders
© Do not show hidden files and folders
Show hidden file:

how and folders
1] e iersions oo e s>
Hide protected operafing system files [Recommended)
[ Launch folder windows in & separste process
() Managing pairs of Web pages and folders

@ Show and manage the pai as a single file

© Show both parts and manage them individually

(O Show both parts but manage as a single file hd

Figure 2-2 Show Extensions for Known Types in Windows Explorer
1. Open Control Panel, and then double click on System.

2. Click on the Advanced tab on the System Properties box (Figure 2-3), and
then click the Environment Variables button.

Standalone License 2-2
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System Properties |2|E|
System Restore Automatic Updates Bemate

Gwad | Comitions | Hatuas

“You must be logged on as an Administrator to make most of these changes.

Perfoimance

Wisual effects, processar scheduling. memany usage, and virtual memony

Settings
User Fraffles
Desktop settings related to your lagon
Settings

Startup and Recovery

System startup, spstem failure, and debugging information

[Erviormentvaiabies ] [ Evor Repating ]

Figure 2-3 System Properties box
3.
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In the System Variables group box (Figure 2-4), look for a variable named

LSFORCEHOST. If the variable already exists, click the Edit button, and
then change the Value to “no-net.” If the variable does not exist, click New.

Environment Variables |2‘®
User variables for zyan
| variable walus
TEMP

C:\Documents and SettingsizyaniLocal ...

™ Ci\Crocuments and SettingstevaniLocal ...

wew | [ edt | [ el |

System variables

Wariable Walug ||
ComSpec CHAWINDOWS)system32icmd, exe
DRSDK_DIR C:\Program FilesMicrasoft Direct® SDK ...
FP_MO_HOST_C... NG
NUMBER_OF_P... 4 |
o) wWindows_MT ]|

[ mew  JI[ et J|[ oelee |

Figure 2-4 Environment Variables box
4.

and value as shown, and then click OK.

In the New System Variable dialog box (Figure 2-5). Enter the variable name

Standalone License
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New System Variable

Variable name: | LSFORCEHOST |

Variable value: ‘ no-net ‘

Figure 2-5 New System Variable box

5. Click t OK on the Environment Variables dialog box. Depending on the
operating system, the computer may have to be restarted in order for the new
environment variable to take effect.

Standalone License 2-4



Chapter 3

Windows Vista

SentinelLM 7.2.0.23 does not formally support Windows Vista, however, our tests
indicate that it is functional on computers running Windows Vista operating
system if the specific guidelines presented below for the evaluation, standalone,

and network licenses are followed.

Evaluation License

StructurePoint software with an evaluation license (i.e. the default unlocked 15 day
trial or a locked license with an expiration date) must be run with administrator
privileges. To do this, select path Start | All Programs | StructurePoint |
spMats, right click on spMats, and then select Run as administrator from the

pop-up menu as shown in Figure 3-1.

Windows Movie Maker

Windows Photo ( Open

& Windows Update
Accessories
Application Verifi
Extras and Upgrat

Games Add to Quick Launch
Maintenance

Micrasoft Office

Microsoft SQL Se Send To

Microsoft Visual §

Microsoft Windoy €Ut

PCA Programs Copy

Startup
StructurePeint

Delete

spMats Rename

& Check For Properties
28 spMats
@ spMats Help
|| spMats Manual

|| Software Quick Start Guide
5 Uninstall spMats

Back

Start Search

@ Run as administrator
Open file location
Pin to Start Menu

Restore previous versions

Figure 3-1 Run as administrator on Windows Vista




Standalone License

To activate StructurePoint software by entering the license code (e-mailed to you)
into the license activation screen, administrator privileges are required and the
software must be started as an administrator (Figure 3-1). Once the software is
activated successfully, administrator privileges are not required to run the
software.

Network License

Vista on License Server

After SentinelLM is installed on the license server computer, follow the steps
below to create an exception (UDP port 5093) in Windows Firewall.

1. Open Control Panel.
2. Open Windows Firewall.

3. Click on Allow a program through Window Firewall as shown in Figure
3-2.

& Windows Firewall

¥ Turn Windows Firewall on or Windows Firewall
off

Windows Firewall can h
Internet or network.

13 Allow a program through
Windows Firewall

Figure 3-2 Access Windows Vista Firewall Settings

4. On the Exceptions tab in the Windows Firewall Settings window, click the
Add port button.

5. Enter “SentinelLM” in the Name text box, “5093” in the Port number text
box, and select the UDP radio button (Figure 3-3). Click OK.

Windows Vista 3-2
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@ Windows Firewall Settings

General | Exceptions | Advanced

=1

Exceptions control how programs communicate through Windows Firewall, Add a
program or port exception to allow communications through the firewall.

Windows Firewall is currently using settings for the private network location.
What are the risks of unblocking & program?

To enable an exception, select its check box:

Program or port

[1BITS Peercaching

Oconnect to a Network Projector
[ Care Netwarking

[pistributed Transaction Coordinator
File and Printer Sharing
[Jiscs1 Service

[Media Center Extenders

[#A Network Discovery
[Performance Logs and Alerts
[CIRemote Administration
ARemote Assistance

[JRemate Desktop

[ 1= =

m

Notify me when Windows Firewall blo

=

Add a Port

Use these settings to open a port through Windows Firewall, To find the
part number and protocol, consult the documentation for the program or

service you want to use.

Name: SentinelLM
Part number: 5093
Protocol: &1

What are the risks of opening a port?

Change scope...

==

Figure 3-3 Create UDP port 5093 Exception in Windows Vista Firewall

6. Make sure the SentinelLM entry appears in the list and is checked as shown in

Figure 3-4. Click OK to close the Firewall Settings window.

Windows Vista



i Windows Firewall Settings (E=3)

General | Exceptions | Advanced

Exceptions control how programs communicate through Windows Firewall. Add a
program ar port exception to allow communications through the firewall.

Windows Firewall is currently using settings for the private network location.
wihat are the risks of unblocking a program?

To enable an exception, select ts check box:

Program or part
[remote Desktop

[JRemote Event Log Management
[remote Scheduled Tasks Management
[JRemote Service Management
[remate Volume Management Tl
[JRouting and Remote Access

SentinelLM

[ISNMP Trap

[ Wwindows Collaboration Computer Mame Registration Service
[ Windows Firewall Remote Management

[ windows Management Instrumentation (WMI)

[ Windows Media Player

i drisie Wlin Dlmssne blevbssnely Charin Enesdze

[Add program... ] [ Add port... ] [ Properties ] [ Delete ]

[¥] Motify me when Windaws Firewall blocks & new program

Figure 3-4 Make Sure the Exception is Checked

Vista on Client Workstation

This scenario assumes that your license server is running and the name or IP
address of the license server has been entered into the 1shost.txt file in the
StructurePoint software folder on client workstations. Administrator privileges are
not required to run the StructurePoint application on client workstations.

Windows Vista 34
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